When exported from Japan, this manual does not require application to the Ministry of International Trade and Industry for service transaction permission.

Specifications subject to change without notice.
Revisions

* The manual number is noted at the lower left of the back cover.

<table>
<thead>
<tr>
<th>Print Date</th>
<th>Manual Number</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sep., 1997</td>
<td>IB (NA)-66792-A</td>
<td>First printing</td>
</tr>
<tr>
<td>Jun., 2004</td>
<td>IB (NA)-66792-B</td>
<td>Partial correction</td>
</tr>
<tr>
<td></td>
<td></td>
<td>About the Manuals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Addition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WARRANTY</td>
</tr>
</tbody>
</table>

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 1997 Mitsubishi Electric Corporation
# About the Manuals

The following product manuals are available. Please use this table as a reference to request the appropriate manual as necessary.

## Related Manuals

<table>
<thead>
<tr>
<th>Manual Name</th>
<th>Manual No.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A870GOT Graphic Operation Terminal User’s Manual</strong></td>
<td>IB-66628 (1DM050)</td>
</tr>
<tr>
<td>This describes the configuration of the A870GOT hardware, performance,</td>
<td></td>
</tr>
<tr>
<td>specifications, procedures for installing optional modules, offline operation,</td>
<td></td>
</tr>
<tr>
<td>and troubleshooting.</td>
<td></td>
</tr>
<tr>
<td><strong>A850GOT Graphic Operation Terminal User’s Manual</strong></td>
<td>IB-66669 (1DM038)</td>
</tr>
<tr>
<td>This describes the configuration of the A850GOT hardware, performance,</td>
<td></td>
</tr>
<tr>
<td>specifications, procedures for installing optional modules, offline operation,</td>
<td></td>
</tr>
<tr>
<td>and troubleshooting.</td>
<td></td>
</tr>
<tr>
<td><strong>A852GOT Graphic Operation Terminal User’s Manual</strong></td>
<td>IB-66767 (1DM042)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A852GOT main</td>
<td></td>
</tr>
<tr>
<td>module, as well as the hardware configuration, procedures for installing</td>
<td></td>
</tr>
<tr>
<td>optional modules, operation in off-line mode, error codes, and trouble</td>
<td></td>
</tr>
<tr>
<td>shooting guidelines.</td>
<td></td>
</tr>
<tr>
<td>(Included in the A852GOT)</td>
<td></td>
</tr>
<tr>
<td><strong>A853GOT Graphic Operation Terminal User’s Manual</strong></td>
<td>IB-66785 (1DM044)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A853GOT main</td>
<td></td>
</tr>
<tr>
<td>module, as well as the system configuration. (Included in the A853GOT)</td>
<td></td>
</tr>
<tr>
<td><strong>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual</strong></td>
<td>IB-66791 (1DM179)</td>
</tr>
<tr>
<td>(Startup Manual)</td>
<td></td>
</tr>
<tr>
<td>This describes the configuration of the A8GOTP system, precautions</td>
<td></td>
</tr>
<tr>
<td>regarding the configuration, and the specifications of the various</td>
<td></td>
</tr>
<tr>
<td>functions, as well as the installation procedures, startup procedures,</td>
<td></td>
</tr>
<tr>
<td>screen configurations, and basic operation procedures. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td><strong>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual</strong></td>
<td>IB-66793 (1DM176)</td>
</tr>
<tr>
<td>(Monitor Screen Creation Manual)</td>
<td></td>
</tr>
<tr>
<td>This describes procedures for creating monitor screens, monitor functions</td>
<td></td>
</tr>
<tr>
<td>that can be used with the A870GOT, procedures for setting the monitor</td>
<td></td>
</tr>
<tr>
<td>functions, precautions to be observed when creating monitor screens, and</td>
<td></td>
</tr>
<tr>
<td>precautions to be observed when appropriating conventional GOT monitor</td>
<td></td>
</tr>
<tr>
<td>data for use with the A870GOT. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td><strong>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual</strong></td>
<td>IB-66794 (1DM175)</td>
</tr>
<tr>
<td>(Data Transmission/Debugging/Document Creation Manual)</td>
<td></td>
</tr>
<tr>
<td>This manual describes the following items.</td>
<td></td>
</tr>
<tr>
<td>(1) Procedures for downloading project data to the GOT and uploading data</td>
<td></td>
</tr>
<tr>
<td>from the GOT.</td>
<td></td>
</tr>
<tr>
<td>(2) Procedures for installing the operating system in the GOT</td>
<td></td>
</tr>
<tr>
<td>(3) Procedures for using the A8GOTP as a virtual sequencer and for debug-</td>
<td></td>
</tr>
<tr>
<td>ging the GOT.</td>
<td></td>
</tr>
<tr>
<td>(4) Procedures for outputting created monitor data as a completed document</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
<tr>
<td>Manual Name</td>
<td>Manual No.</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>SW3NIW-ABGOTP Graphic Settings Software Package Operating Manual</td>
<td>IB-66795</td>
</tr>
<tr>
<td>(Report Functions Manual)</td>
<td>(1DM178)</td>
</tr>
<tr>
<td>Describes procedures to draw grid lines, set and edit report data using</td>
<td></td>
</tr>
<tr>
<td>the report function.</td>
<td></td>
</tr>
<tr>
<td>(Included in the software package product)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>GOT800 Series Operating Manual</td>
<td>IB-66796</td>
</tr>
<tr>
<td>(Expanded Functions Manual)</td>
<td>(1DM181)</td>
</tr>
<tr>
<td>This manual describes the operation procedures for using system monitor</td>
<td></td>
</tr>
<tr>
<td>functions, monitor functions for special function modules, and the</td>
<td></td>
</tr>
<tr>
<td>dedicated monitor screens used with the circuit monitor functions.</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
</tbody>
</table>
Introduction

This manual is designed for first-time users of the GOT800 Series.
We hope you will use it for hands-on practice as you learn how to operate the equipment.
1. Using the Manuals

When this graphics software is purchased, it comes with six operating manuals. And you get User's manual for GOT, too. Manuals are categorized according to the purpose for which they are used. Please read the manual that corresponds to your particular objective in order to become familiar with the operations and functions of the software.

**SW3NIW-A8GOTP Operating Manual**

- Install the graphics software in the computer.
- Start up the graphics software.
- Learn fundamental information and basic operations for the graphics software.

- Create simple graphics, monitor using the GOT, and learn the flow of a series of operations. Contains the same text as this manual.

- Actually create screens for monitoring using the GOT. Drawing graphics Sprite settings Edit the data which has been created.

- To perform report function, create the report data. Create ruled lines. Set the report data. Edit the report data.
• Install the OS program and communications driver in the GOT.
• Download created graphics to the GOT.
• Debug graphics between the computer and GOT.
• Create data documents.

• Monitor circuits.
• Monitor the system.
• Monitor the special module.

Each of GOT User's Manual

• Install optional module (communications module, power supply module) in the GOT.
• Connect the GOT and PC CPU.
• Find out how to attach the GOT and its external dimensions.
2. Abbreviations and Symbols Used in This Manual

The following abbreviations and symbols are used in this manual.

<table>
<thead>
<tr>
<th>Abbreviation/Terminology</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics software</td>
<td>This refers to the SW3NIW-A8GOTP.</td>
</tr>
<tr>
<td>Computer</td>
<td>This refers to the peripheral device in which the graphics software has been installed.</td>
</tr>
<tr>
<td>A870GOT</td>
<td>This indicates the A870GOT Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A850GOT</td>
<td>This indicates the A850GOT Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A851GOT</td>
<td>This indicates the A851GOT Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A852GOT</td>
<td>This indicates the A852GOT Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A853GOT</td>
<td>This indicates the A853GOT Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A85□GOT</td>
<td>This refers to the A850GOT/A851GOT/A852GOT/A853GOT.</td>
</tr>
<tr>
<td>GOT</td>
<td>This refers to the A870GOT/A850GOT/A851GOT/A852GOT/A853GOT/A810GOT.</td>
</tr>
<tr>
<td>Conventional GOT</td>
<td>This indicates the A77GOT (S3/S5).</td>
</tr>
<tr>
<td>Canvas graphics</td>
<td>This indicates graphics and text data for still images.</td>
</tr>
<tr>
<td>Sprite</td>
<td>This refers to setting data used for moving images.</td>
</tr>
<tr>
<td>Screen data</td>
<td>This is the data specified for canvas graphics and sprites, in units of one screen.</td>
</tr>
<tr>
<td>Common screen data</td>
<td>This is the data for the specified GOT type and screen switching device.</td>
</tr>
<tr>
<td>Comment data</td>
<td>This is character string data created in order to display comments with the message display function.</td>
</tr>
<tr>
<td>Parts data</td>
<td>This is graphic data registered in order to display graphics with the part display function.</td>
</tr>
<tr>
<td>Title data</td>
<td>This is title data that comes with each of the various screens.</td>
</tr>
<tr>
<td>Project data</td>
<td>This refers to all of the data that has been created, and all of the data saved in the specified directory.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This indicates a command on a menu.</td>
</tr>
<tr>
<td></td>
<td>This indicates an icon on the tool bar.</td>
</tr>
<tr>
<td></td>
<td>This indicates a tab on a dialog box.</td>
</tr>
<tr>
<td>&quot;</td>
<td>This indicates a name of a command in a command box.</td>
</tr>
<tr>
<td>[     ]</td>
<td>This indicates a displayed dialog box.</td>
</tr>
<tr>
<td>&lt;     &gt;</td>
<td>This indicates an item in a dialog box for which a setting can be entered.</td>
</tr>
<tr>
<td></td>
<td>This indicates a dialog box command button.</td>
</tr>
<tr>
<td></td>
<td>This indicates a key on the computer keyboard.</td>
</tr>
<tr>
<td>POINT</td>
<td>This indicates that the information is particularly important.</td>
</tr>
</tbody>
</table>
The Contents and Purpose of This Manual

This manual is designed to let you gain hands-on experience with the GOT as you learn. The manual is configured of the following chapters:

1. First, Let's Boot the Software!
   
   In this chapter, you will learn basic operations such as installing the SW□-A8GOTP in the computer, starting up the software, and exiting the software.

2. Let's Draw Pictures!
   
   This chapter describes how to draw and edit figures, and how to create simple screens, with plenty of hands-on practice.

3. Let's Get the GOT Going!
   
   In this chapter, you will learn how to connect the computer and the A870GOT, and how to send the necessary data to the A870GOT.

4. On the Move
   
   This chapter shows you how to monitor the screens you created in Chapter 2 and how to check movements.

5. Creating a Screen
   
   This chapter explains more about creating new screens.

6. Creating a Second Screen
   
   Here, you'll learn how to add a second screen to the one you created in Chapter 5.

7. Checking Movements
   
   This chapter describes how to monitor the screens you created in Chapters 5 and 6, and check the actual movements.
System Configuration Used in This Manual

A870GOT
(STN liquid crystal type)

Bus connection

PC CPU

IBM PC/ AT or IBM PC/ AT compatible

Mouse
# Table of Contents

Introduction
The Contents and Purpose of This Manual
System Configuration Used in This Manual

## 1. First, Let's Boot the Software!

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 Learning the Basics</td>
<td>1-1</td>
</tr>
<tr>
<td>1.1.1 Using the Mouse</td>
<td>1-1</td>
</tr>
<tr>
<td>1.1.2 Screen Configuration</td>
<td>1-2</td>
</tr>
<tr>
<td>1.2 Installing the Graphics Software in the Computer</td>
<td>1-4</td>
</tr>
<tr>
<td>1.3 Starting Up and Exiting the Graphics Software</td>
<td>1-7</td>
</tr>
<tr>
<td>1.4 Learning the Overall Flow</td>
<td>1-9</td>
</tr>
<tr>
<td>1.5 Operating After Starting Up Graphic Software</td>
<td>1-10</td>
</tr>
<tr>
<td>1.6 About the Screen Images Shown in Chapter 2 and After</td>
<td>1-11</td>
</tr>
</tbody>
</table>

## 2. Let's Draw Pictures!

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1 Learning to Draw Graphics</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1.1 Selecting Attributes</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1.2 Drawing Straight Lines, Rectangles, Circles, and Arcs</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1.3 Drawing Polygons and Continuous Lines</td>
<td>2-2</td>
</tr>
<tr>
<td>2.1.4 Inputting Text</td>
<td>2-4</td>
</tr>
<tr>
<td>2.2 Editing Data (Graphics and Sprites)</td>
<td>2-5</td>
</tr>
<tr>
<td>2.3 Creating a Screen</td>
<td>2-8</td>
</tr>
<tr>
<td>2.4 Saving the Created Screen Data</td>
<td>2-9</td>
</tr>
<tr>
<td>2.5 Reading Data From a Floppy Disk</td>
<td>2-10</td>
</tr>
</tbody>
</table>

## 3. Let's Get the GOT Going!

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Connecting the Computer and the GOT</td>
<td>3-1</td>
</tr>
<tr>
<td>3.2 Installing the Operating System in the GOT</td>
<td>3-2</td>
</tr>
<tr>
<td>3.3 Downloading Screens</td>
<td>3-3</td>
</tr>
</tbody>
</table>

## 4. On the Move

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1 Connecting the Computer</td>
<td>4-1</td>
</tr>
<tr>
<td>4.2 Monitoring</td>
<td>4-2</td>
</tr>
</tbody>
</table>

## 5. Creating a Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Setting Up a New Screen</td>
<td>5-1</td>
</tr>
<tr>
<td>5.2 Making a Sample Screen</td>
<td>5-2</td>
</tr>
<tr>
<td>5.3 Entering Sprite Settings</td>
<td>5-3</td>
</tr>
</tbody>
</table>

## 6. Creating a Second Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1 Entering Screen Switching Settings</td>
<td>6-1</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>6.2 Making a Sample Second Screen</td>
<td>6-5</td>
</tr>
<tr>
<td><strong>7. Checking Movements</strong></td>
<td>7-1-7-2</td>
</tr>
<tr>
<td>7.1 Monitoring</td>
<td>7-1</td>
</tr>
<tr>
<td>7.2 The Sequence Program Used for Practice</td>
<td>7-2</td>
</tr>
<tr>
<td>Appendix</td>
<td>A-1-A-25</td>
</tr>
<tr>
<td>Appendix 1. Supplementary Assignment</td>
<td>A-1</td>
</tr>
<tr>
<td>Appendix 2. Getting Familiar With Terminology</td>
<td>A-12</td>
</tr>
</tbody>
</table>
Chapter 1

First, Let's Boot the Software!
1. First, Let's Boot the Software!

1.1 Learning the Basics

In this chapter, you will learn basic operations, such as using the mouse, the meanings of keys, and items on the menus.

1.1.1 Using the Mouse

Clicking ...
Clicking means pressing the button once and releasing it, without moving the mouse.

Double-clicking ...
Double-clicking means pressing the button twice within a specified time and releasing it, without moving the mouse.

Dragging ...
Dragging means holding down the button as you move the mouse.

Clicking, double-clicking, and dragging are all done with the left button of the mouse.
Now, when we use the words "click", "double-click", and "drag", you'll know what they mean.
1.1.2 Screen Configuration

Title bar
This is where the names of the window and the screen are displayed.

Menu bar
A menu is selected by clicking on it to display a drop-down menu.

Drop-down menu
Items on the menu are selected by clicking on them.

Document window
(Screen window)

Tool bar

Status bar
Information about the current screen is displayed here.

Scroll bars
The scroll bars can be moved to display sections of the document window that aren't currently visible.

Tab
Clicking on this changes the page.

Command button
Clicking on this enters the settings.

Command button
Clicking on this closes the window without saving the settings.
Spin box
Clicking on these increases or decreases the numeric value in the spin box by 1.

List box
Clicking on this displays a list of the various types of data.

Radio button
Clicking on this selects the item.

Check box
Clicking on this selects the item, or cancels the item if it has already been selected.
Describe the way to install GOT800PSET.

1. Turn on the power supply to the computer.
2. Start up MS-Window Ver. 3.1 or Windows 95.
3. Insert the floppy disk in the drive of the SW3NIW-A8GOTP 1/6.
   Check the drive into which the disk has been inserted.
4. Execute [Set up exe] on the floppy disk.
5. After setting ① to ⑤ on the screen below, click on [Install].
   The installation process begins.

[Screen to be displayed]
[Setting contents]

① Check box

Place an “X” mark in the check box of □SW3NIW-A8GOTP, □SW3NIW-A8SYS, or □SW3NIW-A8GMDP.

(The check box of SW3NIW-A8GMDP does not need to be selected when the special function module monitor function is not being used.)

② Select Item button

Set the item to set up and sample screen to install.

Graphic software is installed. Graphic software for reports is installed.

Set the library number where the basic graphics library will be installed.

③ Browse button

Click on [Browse], specify the installation destination password of the SW3NIW-A8GOTP, SW3NIW-SY SYS, or SW3NIW-A8GMDP.

Select the directory of the installation destination.

Select the drive of the installation destination.
4. **OS Select** button

Clicking on **OS Select**, select the GOT to use, OS program and communication driver to be installed in the [Item Select] dialog box.

Select the GOT to use.

<table>
<thead>
<tr>
<th>Select Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please click left button to move items from 'Install' / 'Not install' to 'Not install' / 'Install'.</td>
</tr>
</tbody>
</table>

**GOT Type**
- A870081GOT
- A8C*GOT

**Not install:**
- Standard monitor
- ROM_BIOS
- System monitor
- Sys. unit monitor
- MELSEC-A Ladder monitor
- MELSEC-FX Ladder monitor

**Install:**
- Select the function which will be installed or not by clicking

5. **Module Select** button

Clicking on **Module Select**, select the special function module monitor data to be installed in the [Item Select] dialog box.

Select the function which will be installed or not by clicking

<table>
<thead>
<tr>
<th>Select Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please click left button to move items from 'Install' / 'Not install' to 'Not install' / 'Install'.</td>
</tr>
</tbody>
</table>

**Not install:**
- A672DA-51
- A1562DA
- A61EDV, A61EDM
- A15880AV, A15880AI
- A68AD
- A858DM
- A1588AD
- A616AD
- A1585AD
- A616TD
- Select the function which will be installed or not by clicking

**Install:**
- OK
- Cancel
1.3 Starting Up and Exiting the Graphics Software

When the program has been installed, you can try starting and exiting it.

[START] Boot the Windows program.

(1) Double-click on this.

(2) Double-click on this.

[A8GOTP startup completed]
Click on the “Project (P)” position.

Click on “Exit A8GOTP (X).”

[A8GOTP exited]
1.4 Learning the Overall Flow

Before you actually try creating a screen, let's look at the whole series of operations.

Start

Install the software package (SW□-A8GOTP).

Create the user-specified screen data.

Connect the GOT and computer through the RS232C, and turn on the power supply to the GOT.

Is this the first time the GOT is being reset?

No

Yes

Install the OS and communications driver.

Send the user-specified screen data.

Connect the sequencer and start the program (turn off the power supply to the GOT).

End
1.5 Operating After Starting Up Graphic Software

After booting the graphics software, set the GOT type in the screen data as the first operation to be run.

(1) Click on the "Common" settings menu.

(2) Click on GOT Type.

(a) Click on "A870GOT-TFT, STN". Click on "A870GOT-EL" when using A870GOT-EL. Click on "A85*GOT-STDN, L" when using the A85□GOT.

(b) Click on OK.
1.6 About the Screen Images Shown in Chapter 2 and After

A part of display contents of the screen images shown in chapter 2 and after in this manual is different from those of SW3NIW-A8GOTP. However, there should be no problem in selecting menus or operation of the actual screen.

For the items that are different from the actual screen, read them as corresponding items of the SW3NIW-A8GOTP screen.
Chapter 2

Let's Draw Pictures!
2. Let's Draw Pictures!

2.1 Learning to Draw Graphics

In this section, you'll learn how to draw graphics. Try drawing all kinds of pictures for yourself, using this page as a reference.

2.1.1 Selecting Attributes

Before you create a graphic, you need to select the attributes for it.

Click on the arrow button in the list box to specify a line style.

Click on the arrow button in the list box to specify a line thickness.

Click on the arrow button in the list box to specify a line color.

Click on the arrow button in the list box to specify the dot unit by which the figure will be moved.

Click on the arrow button in the list box to specify the color of the fill pattern.

Click on the arrow button in the list box to specify the way in which the figure will be filled in.

2.1.2 Drawing Straight Lines, Rectangles, Circles, and Arcs

To draw straight lines:

- Click here: [ ]

Example:

(1) Press the left button at the starting point of the line.
(2) Drag the mouse to move the cursor.
(3) Release the button at the ending point.

POINT

Rectangles [ ], circles [ ], and arcs [ ] are drawn in the same way.

Referring to the method for drawing straight lines, try drawing a figure.
2.1.3 Drawing Polygons and Continuous Lines

To draw a polygon:

- **Click here:**

  - **Example:**

  ![Diagram showing steps to draw a polygon]

  1. Click at the starting point of the polygon, and drag the mouse to point (2) without releasing the button.
  2. Release the left button at the second corner position. (This is the same method used to draw a straight line.)
  3. Click the left button at the third corner position. (Click on each of the subsequent corner positions to continue drawing the polygon.)
  4. Double-click at the final corner position.

**POINT**

The same process is used to draw continuous lines.

Referring to the process for drawing a polygon, try drawing a figure.

---

**Attributes can be changed using the Change Attribute menu**

The Change Attribute menu can be displayed by selecting **Change Attribute** on the Edit menu, or by double-clicking anywhere on the figure. The following contents are displayed.

- **Clicking here displays the Change Attribute screen for the pattern.**
- **Clicking here selects the type of line.**
- **Clicking here selects the line width.**
- **After the attributes have been specified, click here.**
- **Click here to close the window without specifying the attributes.**
- **Click on the line color.**

- **Clicking here displays the Change Attribute screen for the graphic.**
- **Clicking here selects the attributes for the graphic.**
- **After the attributes have been specified, click here.**
- **Click here to close the window without specifying the attributes.**
- **Click on the color of the graphic.**

2 - 2
POINT

Figures not painted...

1. Click on \[\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{？}\\text{
2.1.4 Inputting Text

(1) Click on [A].
(2) Specify the attributes, and click on [OK].
(3) Enter the text, and click on [OK].
(4) Move the square drawn in dotted lines to the display position, and click there.

**Setting menu for text graphics**

- Specify the text attributes.
- Click here to close the window without specifying the attributes.
- Click here after inputting the text using the keyboard.
- Select the text display format.
- Select the text outline color.
- Select the horizontal expansion of the text.
- Select the vertical expansion of the text.
- After the attributes have been specified, click here.
- Click here to close the window without specifying the attributes.
- Click on the color of the text.
- Select the direction in which text is to be displayed.
2.2 Editing Data (Graphics and Sprites)

(1) Select the data to be edited (when one data item is to be selected)

1) Select (click on) [ ].

2) Click in the selected data [ ].

(2) Select the data to be edited (when more than one data item is to be selected)

1) Select (click on) [ ].

2) Starting at the top left of the data [ ] to be selected, drag the mouse to the lower right corner [ ] , forming a box around the data items.

(3) Change the data size (expansion/reduction)

1) Select [ ] . and, referring to “(1) Select the data to be edited”, select the data to be expanded or reduced.

2) Place the cross-shaped cursor at the block point which marks the starting point of the selected data [ ] , and drag it in the direction in which it is to be expanded or reduced.

POINT
If the [Shift] or [Ctrl] key is held down while changing the size as described in step (2) above, the following results:

- Shift key: Proportional change in shape
- Ctrl key: Centered change in shape

The data can be expanded or reduced proportionally.

Various other operations are also available. For more detailed information, please refer to the instruction manual.
(4) Move the data

1) Click on the select button, and, referring to "(1) Select the data to be edited", select the data to be moved.

2) Align the arrow-shaped cursor with the data to be moved. (The cursor changes to a cross-shaped cursor.)

3) Holding down the mouse button, drag the cursor to the position to which the data is to be moved, and release the button.

(5) Editing on other menus

Click on the Edit menu and then click on the item to be selected, or click on the corresponding icon to select the item. The data can then be edited. (The contents are outlined below.)

---

Edit menu

- **Undo** .............. This deletes the last change that was made to the data and returns the data to the status it was in before it was edited. (Only one data item can be recovered.)

- **Cut** .............. This deletes the selected data from the screen and stores it temporarily.

- **Copy** .............. This copies the selected data to a temporary storage area.

- **Paste** .............. This retrieves the data from the temporary storage area and pastes it on the screen.

- **Copy/Paste** ....... All of the selected data is copied and pasted on the edit screen.

- **Edit Text** ......... This sets the target of the editing or selection as text.

- **Edit Vertex** ....... This sets the angles of a continuous line or polygon as the target of the editing or selection.

- **Object of Selection**

  - **Figure** .......... This sets a graphic as the target of the editing or selection.

  - **Sprite** .......... This sets a sprite as the target of the editing or selection.

  - **Figure + Sprite** .... This sets a graphic plus a sprite as the target of the editing or selection.

- **Select All** ........ This selects all of the targets selected using the [Object of Selection] command on the Edit menu.

- **Group** .............. This groups the selected data items as one graphic.

- **Ungroup** ............ This cancels the grouping of the selected data items.

- **Rotate/Flip** ........

  - **Flip Vertical** ...... This reverses the top and bottom of the selected data (except for text and images).

  - **Flip Horizontal** .... This reverses the left and right sides of the selected data (except for text and images).

  - **Rotate Left** ......... This rotates the selected data (except for images) 90° to the left.

(Continued on next page)
(Continued from previous page)

Align
- Center ............... Aligns the selected data along the center.
- Top .................. Aligns the selected data along the top.
- Top evenly .......... Aligns the selected data along the top, spaced at even intervals.
- Bottom ................ Aligns the selected data along the bottom.
- Left ................... Aligns the selected data along the left.
- Left evenly .......... Aligns the selected data along the left, spaced at even intervals.
- Right .................... Aligns the selected data along the right.

Stacking Order
- Bring to Front ...... Positions the selected data at the front of all the screens.
- Send to Back ...... Positions the selected data at the back of all the screens.

Attribute ................ Used to change or specify the attributes of the graphic being drawn or already drawn.

Edit Sprite ............... Used to correct, divert, or delete a sprite.

Replace Devices........... This changes all of the specified device names and device addresses.

(6) Cutting data 

1) Click on , and, referring to "(1) Select the data to be edited", select the data to be cut.
2) Click on Cut on the Edit menu, or on the Cut icon .

(7) Copying data 

1) Click on , and, referring to "(1) Select the data to be edited", select the data to be copied.
2) Click on Copy on the Edit menu, or on the Copy icon .
3) Click on Paste on the Edit menu, or on the Paste icon , and then click on the position to which the data is to be copied.
4) After the data which was stored in the temporary storage area is displayed, click on the position at which the data is to be pasted.

(8) Pasting data 

1) Click on Paste on the Edit menu, or on the Paste icon .
2) After the data which was stored in the temporary storage area is displayed, click on the position at which the data is to be pasted.

POINT
Sprites are edited in the same way as graphics (although there are some functions which cannot be used with sprites).
2.3 Creating a Screen

In this section, we will try creating a simple screen, in order to see how it's done. The screen we create here will be used in Chapters 3 and 4, in order to follow through the entire series of operations, all the way up to monitoring it with the GOT.

Referring to Sections 2.1 and 2.2, try creating a screen like the one you see here.

The A870GOT and A85□GOT have different screen sizes.

Try creating the screen image you see illustrated below using your GOT.

<Screen to create>

---

Setting the clock

Click on \[ struggles to draw a button \].

Click on \[ Clock \].

After clicking on \[ OK \], click on the display position.

Click on \[ \], and then on the size in which text is to be displayed.

Click on \[ \], and then on the color in which text is to be displayed.

Click on either “Date” or “Time”, depending on which item is to be displayed.

Click on the sequence in which the date is to be displayed: either year/month/day, or day/month/year.

---
2.4 Saving the Created Screen Data

Now let's save the data you created in Section 2.3 to a floppy disk.

1. Click on the Project menu.

2. Click on [Save As] .

3. Click on MkDir (M) .
   - Click on [ ] and select [a:] .
   - Enter the directory name from the keyboard.
   - (Example: sample )
   - Click on [OK] .

4. Click on [OK] .
2.5 Reading Data From a Floppy Disk

Now let's look at how to read out the data that you stored on the floppy disk in Section 2.4. If the data that you need is already in the document window, you don't need this step.

1. Click on the Project menu.

2. Click on Open.

3. 1) Click on and specify the floppy disk drive.
    2) Specify the name of the directory containing the data.
    3) Click on OK.
Chapter 3

Let's Get the GOT Going!
3. Let's Get the GOT Going!

3.1 Connecting the Computer and the GOT

This section describes how to connect the computer and the GOT to send the created data.

POINT
Use an RS-232C cable for connection!

Handling RS-232C cable connected PC ↔ GOT, see 2-2 in the SW3NIW-A8GOTP operating manual (Data Transmission/Debugging/Document Creation Manual).
3.2 Installing the Operating System in the GOT

Here, in preparation for monitoring, we will install the operating system program and the communications driver in the GOT.

The GOT does not contain the operating system or the communications driver needed for monitoring. Before monitoring for the first time, therefore, these must be installed. After the first time, these programs do not need to be installed again, but if updated versions come out, the same procedure can be used to update the previous versions of the software.

The procedure is outlined below.

1. Click on the Communication menu.

2. (1) Click on Install (1) Menu.
   (2) Click on [OS (O)].

3. (1) Select "HD".
   (2) Click on "A870/810GOT" or "A85□GOT".
   (3) Click on "A85□GOT" when using A85□GOT.
   (4) Click on and then on "Bus Connection".
   (5) Click on Install .
3.3 Downloading Screens

In this section, we will download the screen we created in Chapter 2 to the A870GOT. The procedure is as noted below.

(1) Click on the Communication menu.

(2) Click on Download.

(3) Click on Monitor Data.
Click on [Download].

Project title:
GOT Type: A870GOT-TFT, STN
Transfer size (byte): 172
Author:

Click on [YES].

The downloading process begins.
Chapter 4

On the Move
4. On the Move

4.1 Connecting the Computer

In this section, we will connect the PC CPU and the bus, so that we can begin monitoring.

**CAUTION**
Make sure the power supply is off before you connect the GOT.

**POINT**
Connect the PC CPU using an expansion cable!

A bus connection unit (A7GT-BUS) is required to connect the bus.
4.2 Monitoring

Now let's try monitoring the screen we created in Section 2.3.

<GOT monitor screen>

![GOT screen with today's date and current time]

 Displays the date (year/month/day) Displays the time

**Attention!**
The values on this screen will not be displayed correctly unless the CPU date and time have been set. Use a GPP or similar device to set the CPU date and time.
Chapter 5

Creating a Screen
5. Creating a Screen

5.1 Setting Up a New Screen

We will now leave the screens we have set up in the previous chapters, and make screens in a new directory.

(1)

(2)

(3)
5.2 Making a Sample Screen

Let's make another screen here.

The A970GOT and A85□GOT have different screen sizes. Try creating the screen image you see illustrated below using your GOT.

Steps A - D are explained on the following pages.

First, try making a screen like the one shown below.

Make this screen using text and squares!
5. Creating a Screen

5.3 Entering Sprite Settings

Here, we’ll enter the settings for the sprites on the first screen.

Sprites are only explained here through hands-on practice. For detailed information, please see the pertinent information manual.

To enter sprite settings ...

1. Click on SP.

2. The sprite menu box is displayed.
   Click on the function to be specified in order to select it, and enter the setting.

- Sprites set on the first page
  - Numeric displays
  - Lamp displays
  * Numeric input
  * Touch switches
* Numeric displays

Click on [Dev.], and set the monitor device (See step ① below).

↓

Click on [Edit.], and specify the attributes for the text to be displayed (See step ② below).

↓

Click on [OK].

↓

Click at the location where the numeric value is to be displayed.

① Setting the device

Click on [ ], and specify the device.

Click on the [ ] column to display the I-shaped cursor, and input the device number from the keyboard. (The value can be input either by clicking on the up and down arrows, or by entering it from the keyboard.)

Click on [OK].

Device used in this exercise

A → D12  B → D13 (For A and B, please refer to the numeric value display section in the screen on page 5-2.)

②

Click on [ ] and specify the color in which the text is to be displayed.
* Numeric input

Click on [Dev], and specify the monitor device (See step ① below).

↓

Click on [OK].

↓

Click at the location where the numeric value is to be displayed.

① Setting the device

Click on [ ], and specify the device.

(Click on the [0] column to display the l-shaped cursor, and input the device number from the keyboard. (The value can be input either by clicking on the up and down arrows [ ], or by entering it from the keyboard.)

Click on [OK].

②

Click on [Edit], then set the display range.

(See step ③ below)

③

Click on [All area].

Device used in this exercise

⑤ → D10 ⑥ → D11 (For ⑤ and ⑥, please refer to the numeric value display section in the screen on page 5-2.)
* Lamp displays

Click on [Dev.], and specify the monitor device (See step ① below).

↓

Click on [Select], and specify the lamp attributes (See step ② below).

↓

Click on [Display Format], and specify the lamp attributes (See step ③ below).

① Setting the device

Click on [ ], and specify "Bit" as the device type.

Click on [ ], and specify the device.

Click on the [ ] column to display the I-shaped cursor, and input the device number from the keyboard. (The value can be input either by clicking on the up and down arrows [ ], or by entering it from the keyboard.)

Click on [OK].

Device used in this exercise

X00 ~ X07 Set a total of eight devices. (The same procedure is used to set all eight devices.)

② Setting the shape

Click on [OK].

Click on the lamp shape which will be used.
3. The way to display

Specify the color of lamp when it is ON/OFF.

Click on OK.

Click on position at which the lamp is to be displayed.

POINT

When entering several settings in succession, clicking on "Next" copies the contents of the current information after it has been set.
* Touch switches

Click on "Device".

↓

Click on [Dev.], and set the device for which the display is to be switched. (See step ① below.)

↓

Click on [Key], and select "Basic figures" for the shape.

↓

Click on [ON], and in the "Select Figure" dialog box, select the attributes for the figure when the device specified at step ① as the display switching device is on.

↓

Click on the [Action] tab, and enter the settings. (See step ③ on the following page.)

↓

① Setting the device

Click on [4], and specify the device.

Click on the [0] column to display the I-shaped cursor, and input the device number from the keyboard. (The value can be input either by clicking on the up and down arrows [2], or by entering it from the keyboard.)

Click on [OK].

Device used in this exercise

Y70 - Y77  Set a total of eight devices. (The same procedure is used to set all eight devices.)

② Setting the attributes

Click on [SWITCH 4].

Click on [OK].
Click on [Bit] and specify the device from which data is to be read. (See (a) below).

Click on [OK].

In this exercise, we will enter a setting that turns the touch key alternately on and off each time it is pressed. To do this, first click on "Alternate" to select it.

Click on [Dev.] and specify the device to be used for writing (see below).

Click on [OK].

Setting the device

Click on [Type], and specify the device.

Click on the [0] column to display the I-shaped cursor, and input the device number from the keyboard. (The value can be input either by clicking on the up and down arrows [ ], or by entering it from the keyboard.)

Click on [OK].

--- Device used in this exercise ---

Y70 ~ Y77 Set a total of eight devices. (The same procedure is used to set all eight devices.)

(4) Click on the location where the touch switch is to be activated.
**POINT**

Use the following procedure to specify the touch key used to display the ten-key window:

- Select the key window.
  - Click on **OK**.

Enter the settings as shown above.
Chapter 6

Creating a Second Screen
6. Creating a Second Screen

6.1 Entering Screen Switching Settings

Before creating a second screen, settings have to be entered that enable you to switch from the first screen to the second. The following two settings are needed to switch screens:

* Setting the screen switching device (we will use "D999" for practice)

1. Click on the "Common" settings menu.

2. Click on [Scr. Switching Device].

3. Click on [Dev.].
**Setting the touch key used to switch screens**

1. Let's create our screen using rectangles and text. You can use any attributes you want.

2. Click on ③.
Click on **Touch Key**.

Click on "Action".

Click on **Base**.

Click on "Fixed".

Click on **Device** (For this exercise, specify "2", to switch to the second screen.)

Click on **OK**.

Click on **OK**.

Click on **Screen 2** in the screen which you have created. (The screen can be expanded using the same procedure as for expanding figures.)
Screen Switching Devices

When switching screens, the device must always be determined, and must be specified as the screen switching device.

The data contained in the specified screen switching device will serve as the screen number displayed on the GOT.

For this reason, the screen switching device number should not be used for any purpose other than screen switching (it may be used if you are sure the screen switching operation will not be affected, but should be avoided as a rule).

Generally, word devices such as "D" and "W" should be used as the screen switching device. A "GD" device can also be used.

The "GD" Devices

The "GD" is an internal register of the GOT. GD64 ~ GD1023 devices are available. Because the "GD" is a device belonging to the GOT itself, it can only be used in the GOT. Devices such as "D" and "W", however, belong to the PC CPU, and thus the screen number can be controlled through the sequence program.
6.2 Making a Sample Second Screen

At this point, let's make our second screen.

The A870GOT and A85□GOT have different screen sizes. Try creating the screen image you see illustrated below using your GOT.

Sections (5) and (8) are explained a little later on.

A line supply conveyor stopped. Check power.

Try making a screen like the one shown here.
First, bring up the editing screen that you need to make the second screen.

1. Click on the "Screen" menu.

2. Click on [Load].

3. Click on the screen number to "2".

Click on [OK].
First, before setting the sprites, specify any comments to be used on the alarm list display. The procedure and comments to be set are as shown below.

1. Click on the “Draw” menu.

2. Click on “Comment”.

3. Click on “Edit”.

4. Input the comment from the keyboard (See below for comment to be Input).  
   Click on and specify the color in which the comment is to be displayed.  
   Click on .
Comments to Input

1. X0  A line supply conveyor stopped. Check power.
2. X1  Emergency stop limit switch triggered. Check workpiece.
3. X2  Workpiece limit switch not triggered. Check for workpieces.
4. X3  Oil low in Machine 1. Add oil.
5. X4  No. of workpieces exceeded 100. Replace brush.
6. X5  Problem with arm ascent. Set correct height.
7. X6  Problem with arm descent. Set correct height.
8. X7  Problem with arm limit movement. Set correct horizontal width.

To enter more than one comment, click on the "2" box on the second screen, and repeat steps (2) and (3). The same procedure is used to enter comments in boxes 3 to 8.
* Level display

Click on  and select "Up".

Specify the line color for the canvas to be used in the level display.

Click on  and specify the monitor device (see  below).

Click on  and specify the attributes for the level display.

Click on  .

Click on the location where the level display is to be produced, and expand it to the size of the level display. (The location is expanded using the same procedure as for expanding figures.)

② Setting the device

Click on , and specify the device.

Click on the column to display the I-shaped cursor, and input the device number from the keyboard. (The value can be input either by clicking on the up and down arrows , or by entering it from the keyboard.)

Click on  .

Devices used in this exercise

⑤ → D12  ⑥ → D13  (For ⑥ and ⑦, see the level display section of the screen)

POINT

The internal coordinates are automatically set to the center of the display frame. With intricate figures, however, if the center of the figure does not match the internal coordinates, the coordinates can be changed by the user.
* Panel meter display

Click on [Dev] and specify the monitor device (see ② below).
↓
Click on [●] and select "Upper half-circle".
↓
Click on [Edit] and select the attributes for the panel display.
↓
Click on [OK].
↓
Click on the location where the panel meter display is to be produced, and expand it to the size of the panel meter display. (The location is expanded using the same procedure as for expanding figures.)

② Setting the device

Click on [●], and specify the device.
Click on the [①] column to display the I-shaped cursor, and input the device number from the keyboard. (The value can be input either by clicking on the up and down arrows [②], or by entering it from the keyboard.)
Click on [OK].

Devices used in this exercise
⑥ → D12  ⑨ → D13  (For ⑥ and ⑨, see the panel meter display section of the screen)

POINT
The upper half-circle used for the panel meter display is displayed automatically when the panel meter is specified. If this results in white being used as the display color for the outline, however, or if you want to specify another color for some other reason, use the canvas to do this ahead of time.

6 - 10
* Alarm list display

Set "8", so that eight comments can be used.  
↓
Click on [Dev.] and specify the monitor device (see (c) below).  
↓
Click on [Dev.] and specify the storage device (see (d) below).  
↓
Click on [OK].  
↓
Click on the location where the alarm list display is to be produced, and expand it to the size of the alarm list display. (The location is expanded using the same procedure as for expanding figures.)

(c) Setting the device

Click on "Continuous".

Click on [Edit].

Click on 0, and specify the device.

Click on the 0 column to display the I-shaped cursor, and input the device number from the keyboard. (The value can be input either by clicking on the up and down arrows , or by entering it from the keyboard.)

Click on [OK].

---

Devices used in this exercise

Monitor device: X00 - X07 (8 points)  Storage device: D20
Chapter 7

Checking Movements
7. Checking Movements

7.1 Monitoring

Downloading the screen we have created and monitoring it produces a screen like that shown below.

The values for D12 and D13 are shown as numeric values.

Data display panel

D10 - D11

Data input panel

Pressing the touch key displays the ten-key window.

Pressing the touch key changes to the second screen.

When external inputs X00 - X07 are turned on, the corresponding lamp lights.

Pressing the touch keys turns external outputs Y70 - Y77 on and off.

The values for D12 and D13 are shown on the level display.

The values for D12 and D13 are shown on the panel meter display.

A line supply conveyor stopped. Check power.

Pressing the touch key changes to the first screen.

Alarm comments set in advance are displayed by turning on comments X00 - X07.
7.2 The Sequence Program Used for Practice

M9031

0

K 10 Z1 ]

K 10 Z1 ]

[ + P K 1 Z1 ]

[ MOV P K 1 Z1 ]

M1

[ MOV P K 175 D12 ]

[ MOV P K 355 D13 ]

M2

[ MOV P K 5365 D13 ]

[ MOV P K 5250 D12 ]

M3

[ MOV P K 2315 D13 ]

[ MOV P K 175 D12 ]

M4

[ MOV P K 5365 D13 ]

[ MOV P K 355 D13 ]

M5

[ MOV P K 2438 D12 ]

[ MOV P K 3575 D13 ]

M6

[ MOV P K 1250 D12 ]

[ MOV P K 5437 D13 ]

M7

[ MOV P K 2438 D12 ]

[ MOV P K 6437 D13 ]

M8

[ MOV P K 1250 D12 ]

[ MOV P K 7452 D13 ]

M9

[ MOV P K 355 D13 ]

[ MOV P K 5340 D12 ]

M10

[ MOV P K 7352 D12 ]

[ MOV P K 355 D13 ]

CIRCUIT END
Appendix 1. Supplementary Assignment

Try making a screen like the one shown below.

The A870GOT and A85□GOT have different screen sizes. Try creating the screen image you see illustrated, below using your GOT.

<Base screen>
Try making a canvas screen like the one shown below.

## Product Line

1. Line Operating Condition
2. Production Condition

### A line Ambient Operating Temperature

<table>
<thead>
<tr>
<th>A line start</th>
<th>A line shut down</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>B line Ambient Operating Temperature</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Product Condition Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finish Indicated Count</td>
</tr>
<tr>
<td>Total Discharged Count</td>
</tr>
<tr>
<td>Actual Finished Count</td>
</tr>
<tr>
<td>Producing Accomplishment Percentage</td>
</tr>
</tbody>
</table>

---

A - 3
* Items ① to ② do not need to be created in this section.
* The color and attribute do not need to be specified in order to create the screen.
<Comments to create>

1. A line supply conveyor stopped. Check power.
2. Emergency stop limit switch triggered. Check workpiece.
3. Workpiece limit switch not triggered. Check for workpieces.
5. No. of workpieces exceeded 100. Replace brush.
6. Problem with arm ascent. Set correct height.
7. Problem with arm descent. Set correct height.
8. Problem with arm limit movement. Set correct horizontal width.
   * The contents of comment is same as actual exercise.

<Parts to create>

* Specifying the color and attribute are not necessary for creating.
<Contents of setting sprites>

<table>
<thead>
<tr>
<th>No.</th>
<th>Sprite</th>
<th>Setting Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>Touch switch</td>
<td>Base switching ... Fixed value 2</td>
</tr>
<tr>
<td>②</td>
<td>Touch switch</td>
<td>Base switching ... Fixed value 3</td>
</tr>
<tr>
<td>③</td>
<td>Panel meter</td>
<td>Device ... D10 Half-circle Minimum value 0 Maximum value 100</td>
</tr>
<tr>
<td>④</td>
<td>Panel meter</td>
<td>Device ... D11 Half-circle Minimum value 0 Maximum value 100</td>
</tr>
<tr>
<td>⑤</td>
<td>Comment</td>
<td>Device ... X00 Comment ... Comment when direct device is on “Take A coolant water temperature abnormal”</td>
</tr>
<tr>
<td>⑥</td>
<td>Comment</td>
<td>Device ... X01 Comment ... Comment when direct device is on “Tank B coolant water temperature abnormal”</td>
</tr>
<tr>
<td>⑦</td>
<td>Alarm list</td>
<td>Device ... M0-M7 (8 points) Plural number Number order storage device ...... D15</td>
</tr>
<tr>
<td>⑧</td>
<td>Numeric value</td>
<td>Device ... D30</td>
</tr>
<tr>
<td>⑨</td>
<td>Numeric value</td>
<td>Device ... D31</td>
</tr>
<tr>
<td>⑩</td>
<td>Numeric value</td>
<td>Device ... D32</td>
</tr>
<tr>
<td>⑪</td>
<td>Numeric value</td>
<td>Device ... D34</td>
</tr>
<tr>
<td>⑫</td>
<td>Lamp</td>
<td>Device ... X06 ON ... Light on OFF .... Light off</td>
</tr>
<tr>
<td>⑬</td>
<td>Lamp</td>
<td>Device ... X06 ON ... Light off OFF .... Light on</td>
</tr>
<tr>
<td>⑭</td>
<td>Lamp</td>
<td>Device ... X07 ON ... Light on OFF .... Light off</td>
</tr>
<tr>
<td>⑮</td>
<td>Lamp</td>
<td>Device ... X07 ON ... Light off OFF .... Light on</td>
</tr>
<tr>
<td>⑯</td>
<td>Touch switch</td>
<td>Expand ... Window</td>
</tr>
<tr>
<td>⑰</td>
<td>Touch switch</td>
<td>Base switching ... Fixed value 1</td>
</tr>
<tr>
<td>⑱</td>
<td>Touch switch</td>
<td>Base switching ... Fixed value 3</td>
</tr>
<tr>
<td>⑲</td>
<td>Numeric input</td>
<td>Device ... D40 Display range ... Full range</td>
</tr>
<tr>
<td>No.</td>
<td>Sprite</td>
<td>Setting Contents</td>
</tr>
<tr>
<td>-----</td>
<td>--------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>20</td>
<td>Numeric input</td>
<td>Device ---- D41 Display range --- Full range</td>
</tr>
<tr>
<td>21</td>
<td>Numeric input</td>
<td>Device ---- D20 Display range --- 0~10</td>
</tr>
<tr>
<td>22</td>
<td>Numeric input</td>
<td>Device ---- D25 Display range --- 0~10</td>
</tr>
<tr>
<td>23</td>
<td>Numeric value</td>
<td>Device ---- CN0</td>
</tr>
<tr>
<td>24</td>
<td>Numeric value</td>
<td>Device ---- CN1</td>
</tr>
<tr>
<td>25</td>
<td>Part</td>
<td>Device ---- D20 0&lt;$V$&lt;10 Indirect blink</td>
</tr>
<tr>
<td>26</td>
<td>Part</td>
<td>Device ---- D25 0&lt;$V$&lt;10 Indirect blink</td>
</tr>
<tr>
<td>27</td>
<td>Part move</td>
<td>Device ------ D20 Indirect Coordinate device ---- D21 Positioning ---- Top left</td>
</tr>
<tr>
<td>28</td>
<td>Part move</td>
<td>Device ------ D25 Indirect Coordinate device ---- D26 Positioning ---- Top left</td>
</tr>
<tr>
<td>29</td>
<td>Touch switch</td>
<td>Expand ---- Ten-key window</td>
</tr>
<tr>
<td>30</td>
<td>Touch switch</td>
<td>Base switching ---- Fixed value 1</td>
</tr>
<tr>
<td>31</td>
<td>Touch switch</td>
<td>Base switching ---- Fixed value 2</td>
</tr>
<tr>
<td>32</td>
<td>Trend chart</td>
<td>Device ---- D30~D32 Upper limit value 10000 Lower limit value 0 Display ---- Right Charts ---- 3 Points ---- 10</td>
</tr>
</tbody>
</table>

* Initial values should be used for items not included above.
  (Items may be changed if necessary.)

* Specifying the color and attribute are not necessary for creating.
<PC CPU program used in supplementary assignment>

```
0  M9031  [ >= K 10 Z ]
   [ < K 10 Z ]
   [ = K 1 Z ]
   [ = K 2 Z ]

[ + P K 1 Z ]
[ MOV P K 1 Z ]
[ MOV P K 3626 D30 ]
[ MOV P K 2035 D31 ]
[ MOV P K 7338 D32 ]
[ MOV P K 235 D34 ]
[ MOV P K 25 D10 ]
[ MOV P K 26 D11 ]
[ MOV P K 119 D21 ]
[ MOV P K 216 D22 ]
[ MOV P K 354 D28 ]
[ MOV P K 216 D27 ]
[ MOV P K 5248 D30 ]
[ MOV P K 7425 D31 ]
[ MOV P K 2547 D32 ]
[ MOV P K 452 D34 ]
[ MOV P K 24 D10 ]
[ MOV P K 24 D11 ]
[ MOV P K 32 D21 ]
[ MOV P K 224 D22 ]
[ MOV P K 430 D26 ]
[ MOV P K 224 D27 ]
```
Appendix 2. Getting Familiar With Terminology

This section contains a list of words used in this manual that may be unfamiliar to you.

---A---

Access key

These keys are used to select a menu item, instead of selecting it from the menu. The initial letter underlined next to the menu item indicates the access key corresponding to that item.

<Operation> [ALT] + [Access key]

Accumulator (A)

This is a type of data register. Data is automatically stored here when a particular PC command is executed. There are two accumulators, A0 and A1. Sixteen-bit data is stored in A0 and 32-bit data in A0/A1.

Address

This indicates a location in the memory. With the PC, there are various memory devices available, such as data registers (D) and internal memories (M). Addresses are used to specify the position of the data within a memory.

Addresses can be expressed in decimal or hexadecimal format.

- Hexadecimal format: X, Y, B, W
- Decimal format: Anything other than the above

Alignment

Alignment refers to positioning the graphics and sprites in a selected area using a specified method. Graphics and sprites can be aligned at the top, bottom, left, right, and center, and can be spaced at even intervals along the top or at the left. Alignment at even intervals along the top is convenient when you want numeric display sprites or other information to be spaced evenly across the top of the screen. In this alignment, all of the target items are spaced at even intervals in the range between the top left coordinates of the leftmost item and the top left coordinates of the rightmost item.

Ambient operating temperature

This refers to the ambient temperature under which the equipment is used after the power supply has been turned on. Because the PC is usually installed inside the panel, the ambient operating temperature is the temperature inside the panel. The GOT may be installed either inside or outside the panel, so please be aware that the ambient operating temperature changes depending on which configuration is used. (See below.)

Correct operation cannot be guaranteed outside these ranges:

- Display section: 0 ~ 40°C
- Sections other than display section: 0 ~ 55°C
Annunciator (F)
This is special bit information (device) used with information concerning a breakdown or other specialized types of information. It differs from other devices in that it is processed in the order in which it is generated in the special data register of the PC.

Attributes (changes)
Parameters such as lines, fill patterns, and text are called “attributes”, and an “attribute change” refers to checking the status of these parameters.
- Lines: Line type, width, and color
- Patterns: Pattern type and color
- Text: Vertical expansion ratio, horizontal expansion ratio, and color

Base screen
This refers to the screen on which the entire GOT display area is displayed. It consists of canvas graphics and sprite settings.

Bit device
This refers to a device which conveys information in 1-bit units within a PC device. With the GOT, each bit of a word device can be used as a bit device.

Bitmap
This is a file format containing pixel images, and is identified by the file extension “.BMP”. The GOT can use bitmaps as canvas graphics or parts data. A BMP file can be output using an image scanner and a commercial graphic software program. Bitmaps are read by selecting “Other Format” under “Read Other Data” on the Project menu.

Buffer memory (BM)
This is a memory inside a special module which is individual to that particular special module. It can be read directly from the GOT, just as with any other device. With the GOT, however, it functions only in regard to the local node.

Calculator link (module)
This refers to connecting the module PC and a calculator (the GOT and a computer) and reading the PC devices. It also refers to the module used to carry out this function.
When the GOT is connected, the communications cassette listed below has to be installed in the GOT.
- A8GT-RS4

With the MELSEC, the following calculator link modules are available:
- AJ71QC24 (for the QnCPU)
- AJ71QU24 (for the ACPU)
- A1SJ71UC24 (for the compact ACPU)

Canvas (figure)
This refers to the fixed information for a screen. It consists of graphic, text, and image data.
Cascade (menu)

When an item on the menu that has a check mark to the right of it is selected, a sub-menu is displayed to the right or left of that item. This is called a cascade menu.

Clear

This means to delete information or reset a value to 0.

Click

This means pressing the mouse button once and releasing it, without moving the mouse.

Comment

This is text information used for the “Comment display” and “Alarm list display” sprite parameters. One comment may consist of up to 512 characters. A maximum of 32,767 comments can be registered for one screen.

Communications driver

This is one type of system software (operating system) which enables communication with a PC. There are dedicated drivers for each type of communication (bus connection, CPU connection, etc.), so always use the operating system installation function to install the driver in the GOT.

Control menu (box)

This refers to the command menu used for window operations such as formatting the screen as an icon or closing the window. The button used to open this menu is called the control menu box.

The control menu box for the Application window is located at the left end of the title bar. The control menu box for Document windows is located at the left end of the menu bar.

Control node

For the MELSECNET/10, this is the node which controls the overall network. There is only one control node per network. Should a problem of any kind occur with the control node, normally one node takes over as a sub-control node (control node shift function) to continue linking data. When the GOT is connected to the MELSECNET/10, setting the address number of the monitor device to “0” serves as a control node setting. If the address number of the monitor device has been set to “0”, the GOT does not change the sub-control node to the monitor even if a control node shift occurs, so the monitor display of the pertinent device is interrupted.

Counter (C)

This is a device which counts the number of effective input items and turns on a contact point when the number reaches the specified value. The counted value is cleared by using the Reset command to reset the counter.

Cyclic (transmission)

With the MELSECNET, this is a function which exchanges data within the same network. The following devices are used: the link relay (B), the link register (W), the link input (X), and the link output (Y). For a GOT connected directly to the MELSECNET, B and W can be used as independent node devices.
Data register (D)

This refers to a PC register used to store numeric values, and is called a "D register". Sixteen-bit or 32-bit data can be uploaded to a D register. Depending on the type of PC, real numbers can be used in some registers, as well as integers.

Debugging (function)

This is a procedure which eliminates errors in the program contents and settings. With the GOT, the user can instruct the system to check whether or not the screen displays are correct. The graphics software has a “debugging function”. When the debugging mode is activated, the computer assumes the role of the PC CPU and communicates with the GOT, as if the GOT were connected to the PC, and a test is run to check screen displays and touch key input. On the debugging screen, batch monitoring of device values can be done, changes can be made to device values, the device status during debugging can be written to a file, and previous files can be read out. This function cannot be used to operate the PC, however.

Default value

This is the initial setting. With settings such as GOT sprite settings, default values have been entered for nearly all of the values, so the process of entering values can be eliminated.

Device

This is a general term referring to the memory located in the PC CPU. Various devices are available, depending on the application at hand, such as input devices (X), output devices (Y), and data registers (D).

Device batch change

This is a function which enables all of the device names for a sprite which has been specified to be changed at one time. It is run by selecting "Device Batch Change" on the Edit menu. Specify the names of the devices prior to the change, the names of the devices after the change, and the number of points to be changed.

Example: To change from 50 points from D100, to 50 points from D200:

D100 → D200
D102 → D202
D140 → D240

Display conditions (read conditions)

This is activated (display or reading of data) only when a specified condition is fulfilled. This condition is called a trigger condition. There are six types of conditions:

- Always: Data is displayed or read out on a constant basis.
- Rise: Data is displayed only at the rise of the specified device.
- Fall: Data is displayed only at the fall of the specified device.
- When on: Data is displayed or read constantly while the specified device is on.
- When off: Data is displayed or read constantly while the specified device is off.
- Timing: Data is displayed or read at the specified timing.
Display method

This enables the display color, movement, and other elements to be changed for each specified screen. Up to eight types of ranges can be specified, including seven types + one other (normally). The range is specified as a comparison expression in terms of the monitor device value. (Example) 100 < device <= 1500, etc.

Double-click

This means pressing the mouse button twice in rapid succession, without moving the mouse. The interval between clicks can be specified by the user.

Double-click time setting

This is used to set the effective time for double-clicking.

<Procedure>
1. Boot the Windows “Program Manager”.
2. Select “Mouse Setting” under “Control Panel” on the Main menu.

Download

This refers to sending screen data from the graphics software to the GOT. Data can be sent in screen modules, as comments, or by part, allowing only the data necessary for a particular operation to be sent. Conversely, “uploading” refers to the process of receiving screen data.

Drag (dragging)

This means holding down the mouse button while moving the mouse.

-----E-----

Expansion cable

When the PC is connected to the GOT through a bus, an expansion cable is used between the expansion base of the PC (the foundation base) and the GOT. Normally, the expansion cable extends a total distance of 6.6 meters or less from the foundation base.

Distance expansion cables designed especially for the GOT, and cables designed to connect several GOT modules using the A7GT-BUS, can be used for an expansion length of several tens of meters.

Expansion file register

This is a register which is used to expand a file register in the memory cassette. The capacity of the expansion file register is set by means of a parameter. The usable capacity which can be specified varies depending on the capacity of the CPU and memory cassette being used.

With the MELSEC-A, the expansion file register is indicated by “R”.
With the MELSEC-QnA, the expansion file register is indicated by “R” and “ZR”.
---F---

Fall (trigger)

A device "falls" when it goes from on to off status. With the GOT, conditions which are displayed only once when the GOT is turned off are referred to as a "fall trigger". Please be aware that, if the device is turned off and then is turned on again too quickly, there may be times when the "off" status cannot be detected, so that the fall trigger cannot be displayed.

If the "Initial Display" parameter is set to "On", this is displayed once when the screen is switched, even if the trigger has not been produced.

File register (R)

This refers to a register in the memory cassette. The capacity of the file register is specified using a parameter. The capacity that can be specified depends on the capacity of the CPU and memory cassette being used.

---G---

GOT type

This specifies the GOT screen size. The screen size can be switched in the graphics software based on this setting.

Graphic operation terminal

This is the term used by Mitsubishi Electric Corporation to refer to its display module. It is abbreviated as GOT.

---H---

Handle

This refers to small filled-in boxes displayed on the square surrounding a graphic when the graphic is selected. When the mouse cursor is moved to a handle, the shape of the cursor changes. If the left button of the mouse is clicked on a handle and the mouse is moved, the graphic can be enlarged or reduced. Also, pressing the SHIFT key while doing this enables proportional enlargement or reduction of the graphic.

---I---

Icon

This is a graphic pattern that you select (double-click with the mouse) when you want to run a function like the A8GOTP in the Windows environment.

Icon button

The icon button is the button at the far right of the A8GOTP Application window, showing the downward arrow. Clicking on this button displays the graphic software program in the form of an icon. Temporarily formatting the software being used as an icon enables other software to be run at the same time.
Index register (Z, V)

This is a register which is added to a device number, to enable the device address to be changed.

With the MELSEC-A, this is expressed as Z or V.

With the MELSEC-QnA, this is expressed as Z.

With the QnA, please be aware that "V" is an edge relay. Also, please be aware that the GOT does not support an edge trigger device.

Input (X)

This refers to a signal input from a source external to the PC. Signals from limit switches and the mechanical system are read and control is initiated by the PC.

Interlock

This is a block which is applied between the end of the operation currently being executed and the next operation, to prevent the equipment from breaking down or running away. Normally, a bit device is used to apply an interlock. This signal is called an "interlock condition". With the GOT, two types of interlock signals can be specified: display conditions and writing conditions.

Display condition : A check of movement conditions using an edge trigger or a level trigger
Display method : A check based on either the display range or the writing range

Internal relay (M)

This refers to signal information which is used within the PC and is not output to any external destination. It is also called a temporary memory.

Intermode test

With the MELSECNET, tests can be run to see if there are any problems with link modules or cables between two nodes. The node with the smaller node number is checked as the main node, and the other as the sub-node.

K

Key word

This is a kind of password assigned to a sequence program. The program cannot be loaded or saved by anyone who does not know the key word.

L

Link relay (B)

With data links, this refers to a bit device which is transferred by means of cyclic transmission. Bit devices can be assigned to the various nodes using link parameters, so that the data written to each node is written only to the device assigned by the local node. Devices assigned by other nodes can read out data, enabling data to be transferred between the various nodes.

Link relay (W)

With data links, this refers to a word device which is transferred by means of cyclic transmission. Word devices can be assigned to the various nodes using link parameters, so that the data written to each node is written only to the device assigned by the local node. Devices assigned by other nodes can read out data, enabling data to be transferred between the various nodes.
Master node

With the MELSECNET, this indicates the PC which controls the entire network. The master node has link parameters. If the master network becomes unable to function because of a problem such as a power supply failure, the network stops.

Maximum display

This refers to displaying the graphics software application or another application so that it fills the entire screen.

Maximum Size button

The Maximum Size button is the upward arrow button located at the right end of the title bar in the A8GOTP application window. Clicking on this button enlarges the graphics software to fill the entire screen (maximum display).

Memory card

Because screen data can be stored in a memory, the memory card is convenient for high-speed copying of data to another GOT. It conforms to JEIDA standards.

Momentary power failure

This is an extremely short power failure. With the PC and GOT, a power outage is only determined to be a power failure if it lasts for 200 ms or longer. If a power failure occurs which lasts longer than this period, initial processing is carried out in the same way as when the power supply is first turned on.

Move part (trajectory display)

This function deletes the part (graphic) displayed immediately previously, and moves the part to a newly specified position (based on coordinate device values), where it is displayed. With the “Move part” sprite, the user can instruct the system to leave the previous part displayed, instead of deleting it. This is called a trajectory display of a part.

Multi-language system

The GOT supports approximately 26,000 characters of languages from all over the world as a standard feature, so it can be used worldwide. Text can be input in languages such as Japanese, Korean, and Chinese, using the FEP of the respective country.

Node address (node)

This is a number assigned to each sequencer and GOT connected to the MELSECNET. Node addresses cannot be used more than once in the same network.

Node number setting switch

With the MELSECNET, this is a switch used to set the node number provided for a link module.
Operating system (OS)

This generally refers to basic software such as a calculator, and is used to run programs created by the user. With the PC, this runs the sequence program, and with the GOT, it runs functions such as setting the windows and touch keys. It is provided by Mitsubishi.

OS Install

This command installs the operating system from the graphics software to the GOT. This is called the OS install function, and is run by selecting “OS Install” on the Communication menu. With the OS install function, the user can select those functions which are necessary from the list below and install them, for a customized operating system.

- Basic functions
- System monitor functions
- Special module monitor functions
- Circuit monitor functions
- Communications driver

<Communications>

For the communications driver, always install the driver that has the name of the method by which the PC is connected.

Output (Y)

This is the signal which outputs the results of PC calculations to an external destination when turned on, and stops output when turned off. The device name is indicated by “Y”. There are three types of PC output: relay, TRIAC, and transistor.

Panel kit (library)

This refers to a group of graphics or sprites which have a single meaning. The information for these individual groups is the panel kit for that particular group. These can be pasted to the screen and arranged in combinations to create a screen. A panel kit library is a configuration of several panel kits registered as a group.

Part

This is configured of graphics, and is used in the “Display parts” and “Move parts” sprite functions. Graphics that can be used in parts include text and image data.

Password

This is a code word specified to keep screen data from the GOT from being uploaded by unauthorized persons. When screen data to which a password has been assigned is uploaded, the registered password must be entered before the data can be uploaded.

Point

This means moving the cursor to the target position on the screen.
Project (file)

A project is a collection of all the information displayed on one GOT. A project consists of data such as canvas graphics information, window screen information, and parts information. These types of information (projects) are created in one directory. The file which handles overall control of the project is called a project file, and is identified by the file extension "SET".

Reversed screen image

When a hard copy of the screen image shown in the screen preview window is printed out, the user can select whether to print the image as it is, or with the black and white sections reversed. The output setting can be specified by selecting "Option" under "Print" on the Project menu, or by selecting "Preview" under "Screen".

Rise (trigger)

A device "rises" when it goes from off to on status. With the GOT, conditions which are displayed only once when the GOT is turned on are referred to as a "rise trigger". Please be aware that, if the device is turned on and then is turned off again too quickly, there may be times when the "on" status cannot be detected, so that the rise trigger cannot be displayed. If the "Initial Display" parameter is set to "On", this is displayed once when the screen is switched, even if the trigger has not been produced.

Screen

There are two types of screens: base screens and window screens. Screens are composed of canvases (graphics) and sprites (settings).

Screen switching

This refers to changing back and forth between a GOT canvas screen and a window screen. To switch screens, one word device needs to be specified for each screen, the canvas screen and the window screen. The device may be the sequencer word device, or the special device designed for the GOT (GD) located in the GOT itself.

Screen preview

This is a function which enables a GOT screen display image to be re-displayed in the graphics software. In order to display a screen preview, one of the four types of communications drivers listed below must be installed, along with the driver containing the name of the method by which the PC is connected.

<table>
<thead>
<tr>
<th>Image</th>
<th>Device</th>
<th>Image + Device</th>
<th>Canvas</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the sprite display image produced when the GOT is run.</td>
<td>Displays the name of the device specified by the various sprites at the specified position.</td>
<td>Displays the images and sprites together.</td>
<td>Displays only the fixed screen information, without the sprites.</td>
</tr>
</tbody>
</table>

Self-diagnosis

This is a function in which the GOT (CPU) detects errors within itself. The test covers the GOT hardware, communications, memory, displays, and other aspects.
Set

This means turning a specified bit of the PC bit device or word device on. The signal is kept on until an RST (reset) signal is received.

Set value

This refers to entering values in advance for the PC timer (T) and counter (C). Fixed values can be set and indirect instructions entered during the sequence program. With the GOT, monitoring and changing of set values can be done from the system monitor screen.

Shift

This refers to moving word device data by a specified number of bits and changing the data. There are left and right shifts.
In a left shift, the projecting information disappears, and 0 is entered as subsequent data. In a right shift, the projecting information disappears, and where formerly there was a positive number, a 0 is inserted, and where there was a negative number, a 1 is inserted.

Shortcut keys

This refers to a certain combination of keys which can be used to perform an operation, instead of opening a menu. With the AbGOT-P, the [Ctrl] key or the [Alt] key is used in combination with an alphabetic key.

<Example> [Ctrl] + [S] keys:
Entering this combination of keys while you are working overwrites the existing project data and saves the revised data.

Special data register (D)/Special register (SD)

This is a data register (D) whose application is determined by the PC. It enables various types of information such as the PC CPU information and MELSECNET information to be viewed.
With the ACPU, these relays are numbered D9000 ~ .
With the QnACPU, a dedicated SD device is used.

Special internal relay (M)/special relay (SM)

This is an internal relay (M) whose application is determined by the PC. It enables various types of information such as the PC CPU information and MELSECNET information to be viewed.
With the ACPU, these relays are numbered M9000 ~ .
With the QnACPU, a dedicated SM device is used.

Special unit monitor function

With this function, the status of the special module can be displayed as a unit configuration diagram, so that the module to be monitored can be selected. The buffer memory and input/output status for the special module can then be monitored on the system screen, and changes can be made to data. There are approximately 200 screens available with each special module, for monitoring purposes. The screens for whichever module is required can be downloaded to the GOT.
These screens are supplied with the SW****-A8GMDP.
Sprite (setting)

This refers to information for moving images, such as numerical displays, parts displays, and touch keys. Sprites are used to set monitor devices, movement conditions, and other information. With this graphics creation software, sprite boxes are displayed using green lines.

Status bar

This is found at the bottom of the graphics creation screen, and displays information such as guide messages and the cursor position. The user can select whether or not the status bar is to be displayed using the “Display” parameter under “Option” on the project menu.

System information

This is information which conveys the GOT status (number of the screen currently being displayed, error numbers, etc.) to the PC, and information which is output from the PC to the GOT (GOT error reset signals, etc.). It is set using word devices.

System information is specified by selecting “System Information” under the “Common” menu. “Readout device” refers to the information read out from the GOT. “Written information” refers to information written to the PC from the GOT.

System monitor (function)

This refers to the GOT system functions which handle device monitoring of the PC and writing. In addition to individual nodes connected to the GOT, system monitors can also be set up for the PCs of other nodes.

- Device group monitor/Registration monitor
- Buffer memory group monitor
- Device SET/RST
- Changes to buffer memory values
- Displays with comments
- Functions for changing other display formats

Ten-keys

These are the keys used to input numeric values from 0 to 9. With the GOT, there is a system ten-key word, so the ten-keys do not need to be set (created) on the screen.

Text file

This is a file which contains only alphanumeric characters and symbols. Comments can be output to a text file and edited using an editor program. They can also be input to a file after being edited. Also, the printing function can be used to output GOT screen information such as sprite settings to a text file. This makes it possible to read the file with a word processor and create original documents.

Timer (T)

This is a device which activates a timer coil following a specified period of time (the value set for the timer), in order to delay or maintain an operation. Two types of timers are available: 10 msec and 100 msec. The timer consists of a contact point, a coil, a current value, and a set value, and on the GOT monitor screen, any values other than the specified value can be monitored and written. Monitoring and writing of the set value is done using the system monitor function.
Title (setting)

With the graphics software, the project title and screen title can be specified, by selecting “Set Title” on the Common menu. These titles are used when information is output using the printing function.

Project title: This is configured of the title information, the detailed information, and the name of the person who created the data.
Screen title: This is configured of the title information and the detailed information.

Title bar

This is the title bar displayed at the top of the application window in the graphics software, and contains information such as the name of the graphics software, the title of the screen being edited, and the icon button.

Tool bar (1/2)

This is a group of icons displayed under the menu bar, which can be selected for functions used relatively frequently, instead of repeatedly having to open the menus. There are two tool bars, and they can be displayed or hidden by selecting “Display” under the “Option” item on the project menu.

Tool bar 1: This group includes functions such as screen drawing, editing, and sprites.
Tool bar 2: This group includes functions such as selecting the display color, line type, and the distance by which the mouse moves.

Touch key

Touching the screen enables the screen to be switched and the data to be written to the device. The minimum unit for the size is one character (16 x 16 dots).

Tri-layer

With the MELSECNET, the local node which is a two-layer “Child” node is used in conjunction with the “Parent” node, and below that are local nodes or remote nodes which serve as “Grand Child” nodes.

Transient transmission

With the MELSECNET, data can be read directly from a PC device of another node. If the node number specified using the GOT monitor device is any number other than the node of that device itself, transient transmission is carried out. Transient transmission requires a communications time several times longer than that of cyclic transmission, so when you want information processed at high speed, it must be sent by cyclic transmission.

Two-layer

With the MELSECNET, this refers to a system configured of one master node and a local node controlled by the master node or a remote node.

Upload

This means using the graphics software to read data from the GOT. The data read from the GOT can then be sent back to the GOT (downloaded) after it has been edited.
<Menu> [Communication] - [Upload]
Vertex Edit

This is an editing function which makes it possible to change the positions of the various vertices of continuous lines and polygons after a screen has been created. To access the function, select “Vertex Edit” on the “Edit” menu. The mode will remain effective until the same item is selected again. When the Vertex Edit mode is on, a check mark is displayed next to the item on the menu.

Window screen

This is a pop-up screen superimposed on the base screen. Touching the button at the upper left of the window closes it. The first line at the top of the window contains the window screen movement keys. Touching a movement key and then any other key moves the window to that position, with the touched position serving as the upper left coordinates of the window.

Word device

This refers to a device which conveys 16-bit (word) information in a PC device. With the GOT, word devices can be read in 16 or 32 bits. Also, the following types of data are supported: integers with positive/negative signs, integers without positive/negative signs, and real numbers.

Word device set

This is a function which writes the specified value to a word device when a touch key is pressed. Types of specifications include fixed values, values of other word devices, and the fixed value added to (or subtracted from) the current device value.
WARRANTY

Please confirm the following product warranty details before starting use.

1. Gratis Warranty Term and Gratis Warranty Range
   If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of the product within the gratis warranty term, the product shall be repaired at no cost via the dealer or Mitsubishi Service Company. Note that if repairs are required at a site overseas, on a detached island or remote place, expenses to dispatch an engineer shall be charged for.

[Gratis Warranty Term]
   The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated place.
   Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair parts shall not exceed the gratis warranty term before repairs.

[Gratis Warranty Range]
   (1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc., which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels on the product.
   (2) Even within the gratis warranty term, repairs shall be charged for in the following cases:
       1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused by the user's hardware or software design.
       2. Failure caused by unapproved modifications, etc., to the product by the user.
       3. When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if functions or structures, judged as necessary in the legal safety measures the user's device is subject to or as necessary by industry standards, had been provided.
       4. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designed in the instruction manual had been correctly serviced or replaced.
       5. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force majeure such as earthquakes, lightning, wind and water damage.
       6. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi.
       7. Any other failure found not to be the responsibility of Mitsubishi or the user.

2. Onerous repair term after discontinuation of production
   (1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued. Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.
   (2) Product supply (including repair parts) is not possible after production is discontinued.

3. Overseas service
   Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA Center may differ.

4. Exclusion of chance loss and secondary loss from warranty liability
   Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation to damages caused by any cause found not to be the responsibility of Mitsubishi, chance losses, lost profits incurred to the user; by Failures of Mitsubishi products, damages and secondary damages caused from special reasons regardless of Mitsubishi's expectations, compensation for accidents, and compensation for damages to products other than Mitsubishi products and other duties.

5. Changes in product specifications
   The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.

6. Product application
   (1) In using the Mitsubishi MELSEC programmable logic controller, the usage conditions shall be that the application will not lead to a major accident even if any problem or fault should occur in the programmable logic controller device, and that backup and fail-safe functions are systematically provided outside of the device for any problem or fault.
   (2) The Mitsubishi general-purpose programmable logic controller has been designed and manufactured for applications in general industries, etc. Thus, applications in which the public could be affected such as in nuclear power plants and other power plants operated by respective power companies, and applications in which a special quality assurance system is required, such as for Railway companies or National Defense purposes shall be excluded from the programmable logic controller applications.
   Note that even with these applications, if the user approves that the application is to be limited and a special quality is not required, application shall be possible.
   When considering use in aircraft, medical applications, railways, incineration and fuel devices, manned transport devices, equipment for recreation and amusement, and safety devices, in which human life or assets could be greatly affected and for which a particularly high reliability is required in terms of safety and control system, please consult with Mitsubishi and discuss the required specifications.
When exported from Japan, this manual does not require application to the Ministry of Economy, Trade and Industry for service transaction permission.

Specifications subject to change without notice.